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ATLAS.ti Quick Tour











About this Quick Tour

Video Tutorial: Overview of ATLAS.ti 22 Mac

Useful Resources for Getting Started

ATLAS.ti Academy

https://youtu.be/24CP6fvGJo4
https://atlasti.com/trainings/


ATLAS.ti Account and Licence Activation

Multi-User License Management Guide for License

Holders & Administrators

Requesting a Trial Version

Trial Desktop

My Applications

Activating a Licence

https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/


Activate License.

Check For Updated License

Accessing Your Account from within ATLAS.ti



Manage Account



Logging Out

Log Out

https://my.atlasti.com/

Log Out

Working Off-Line

off-line



Limited Version after Licence Expiration

Restrictions of the Limited Version



Introduction

Video Tutorial: Overview of ATLAS.ti 22 Mac

The VISE Principle

VISE

Visualization

https://youtu.be/24CP6fvGJo4


Immersion

Serendipity

a seeming gift for making fortunate discoveries

accidentally

serendipity

browsing



Exploration

bureaucratic

Areas of Application

soft data



contextuality



ATLAS.ti - The Knowledge Workbench

knowledge workbench

Some Basic Terms

container

ATLAS.ti project

source data

copied

Project Cloud

text documents

images audio recordings

video clips PDF files

geo data

social network comments

coding

codes

marking annotating

paper and pencil paradigm



margin area

General Steps when Working with ATLAS.ti

Creating a New Project

Adding Documents

Working With Groups

Working With Comments And Memos Coding Data - Basic Concepts

Retrieving Coded Data

Data Analysis Data

Export For Further Statistical Analysis

Working With Networks

Working With

Comments And Memos Exporting Networks

The ATLAS.ti Research Blog The

ATLAS.ti conference proceedings

https://manuals.atlasti.com/Mac/Memos/MemosAndComments.html
https://manuals.atlasti.com/Mac/Querying/QueryingData.html
https://manuals.atlasti.com/Mac/Export/ExportForFurtherStatisticalAnalysis.html
https://manuals.atlasti.com/Mac/Export/ExportForFurtherStatisticalAnalysis.html
https://manuals.atlasti.com/Mac/Memos/MemosAndComments.html
https://manuals.atlasti.com/Mac/Memos/MemosAndComments.html
https://manuals.atlasti.com/Mac/Networks/NetworksExporting.html
https://atlasti.com/research-hub
https://depositonce.tu-berlin.de/bitstream/11303/5404/3/ATLASti_proceedings_2015.pdf
https://depositonce.tu-berlin.de/bitstream/11303/5404/3/ATLASti_proceedings_2015.pdf


Main Steps in Working with ATLAS.ti

Data and Project Management

Supported File Formats

Project Management

Team Work

Two Principal Modes of Working

https://manuals.atlasti.com/Mac/Project/ProjectManagement.html
https://manuals.atlasti.com/Mac/Team/TeamWork.html


Data Level Work

Exploring Data

quotations

note-making/annotating hyperlinking

search retrieval, and browsing functions

Conceptual Level Work

https://manuals.atlasti.com/Mac/Exploring/ExploringTextData.html
https://manuals.atlasti.com/Mac/Quotations/QuotationsTextCreating.html
https://manuals.atlasti.com/Mac/Memos/MemosAndComments.html
https://manuals.atlasti.com/Mac/Hyperlinks/HyperlinksWorkingWith.html
https://manuals.atlasti.com/Mac/Quotations/QuotationReader.html


Querying Data Working With Networks

https://manuals.atlasti.com/Mac/Querying/QueryingData.html


Creating a New Project

Video Tutorial: Creating a project and adding data

Create New Project

https://youtu.be/eqofRUDMcU0


Create



Project > New

Create



Supported File Formats

Textual Documents

Format File Type

Multimedia Transcripts

Transcripts

Transcription

PDF files (Text and Graphic)

https://manuals.atlasti.com/Mac/Transcription/Transcription.html


PDF with annotations / Word files with comments

Imported comments

Imported annotations

PDF documents with annotations imported in ATLAS.ti



Word document with comments

Immporting a codebook

https://manuals.atlasti.com/Mac/Codes/CodeImportExportCodeList.html




PDF files (eBooks, PowerPoint, Spreadsheets, Visio, Draw)

Images

Size recommendation:

Audio- and Video Documents

Adding Documents

Geo Documents

Working With Geo Docs

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Documents/DocumentTypeGeoWorkingWith.html


Social Network Comments

exportcomments.com

Importing Social Network Data

Survey Data

Working With Survey Data

Reference Manager Data

Literature Review

Working With Reference Manager Data.

https://exportcomments.com/
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Documents/DocumentTypeSocialMediaComment.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Documents/DocumentTypeSurveyDataIntro.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Documents/DocumentTypeReferenceManagerData.html


Adding Documents

Video Tutorial: Creating a project and adding data

What happens when you add documents to a project

add

Important for team projects

all entities are stamped with a unique ID when they are created.

merge duplicated codes

Team Work

How to Add Documents

Document > Add Documents.

Reference External Multimedia

Documents Adding Multimedia Data

New Text Document

https://youtu.be/eqofRUDMcU0
https://manuals.atlasti.com/Mac/Team/TeamWork.html
https://manuals.atlasti.com/Mac/Multimedia/MultimediaData.html


import iranscripts Importing Transcripts

prepare your own transcripts

Size Restrictions

A Word about "Big Data"

https://manuals.atlasti.com/Mac/Transcription/ImportingTranscripts.html
https://manuals.atlasti.com/Mac/Transcription/PreparingOwnTranscripts.html




Importing an Existing Project

How to Import Projects

Import Project

Project > Import Project.

Options



If the project contains Linked Media Files

Project File Formats





Project Cloud

privacy policy

Your project will

stay safely on your computer until you decide otherwise.

On this computer

https://atlasti.com/legal/privacy-policy


In the cloud

Both on this computer and in the cloud

How to use



Sharing Projects

Team Work

Current limitations

https://manuals.atlasti.com/Mac/Team/TeamWork.html


Creating a Project Backup

export

ATLAS.ti Project Cloud

project bundle file

transfer projects

Project Transfer

Exporting a Project

Project > Export > Project

Save File Dialog

Exporting partial bundle files

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Project/ProjectManagementTransfer.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Project/ProjectManagementPartialBundle.html


Save

Project Management.

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Project/ProjectManagement.html


Exporting a Project in XML Format

(today UK Data Service)

Project > Export > XML

https://ukdataservice.ac.uk/


Working With Groups

gender::female location::urban family

status::single

Exploring Coded Data

smart group

global filter

https://manuals.atlasti.com/Mac/Codes/ExploringCodedData.html
https://manuals.atlasti.com/Mac/Analysis/AnalysisWhatAreSmartGroups.html
https://manuals.atlasti.com/Mac/Analysis/AnalysisApplyingGlobalFilters.html


Application of Document Groups

Video Tutorial: Organizing documents and document groups

Video Tutorial: Organizing project data - Creating document groups

Code Document

Table

Networks

Application of Code Groups

Code Document Table

building a coding system

Application of Memo Groups

Memos and Comments

https://youtu.be/eivyBCHzVCc
https://youtu.be/wjp1FXo_zVc
https://manuals.atlasti.com/Mac/CodeDocumentTable/CodeDocumentTable.html
https://manuals.atlasti.com/Mac/CodeDocumentTable/CodeDocumentTable.html
https://manuals.atlasti.com/Mac/Networks/NetworksAnalyticFunctions.html
https://manuals.atlasti.com/Mac/CodeDocumentTable/CodeDocumentTable.html
https://manuals.atlasti.com/Mac/Memos/MemosAndComments.html


Groups as Filters

minus (-)

any

all

all



Working with Quotations

Video Tutorial: Working with quotations

The ATLAS.ti Quotation Level

Code Document Table Code Co-occurrence Table

what you can do with quotations

instead to build a well-rounded

code system

https://youtu.be/ym8PaAym9js
https://manuals.atlasti.com/Mac/CodeDocumentTable/CodeDocumentTable.html
https://manuals.atlasti.com/Mac/CodeCooccurrence/CodeCoOccurrenceTable.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Quotations/QuotationsWorkingWith.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Quotations/QuotationsWorkingWith.html


Creating Quotations in Text Documents

Coding Data

Create

Quotation cmd+H.

Modifying Quotation Boundaries



Quotation ID and Reference

Working with Quotations

Adding Quotation Names and Writing Comments

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Quotations/QuotationsWorkingWith.html


Building a Code

System

Working with Multimedia Data

https://manuals.atlasti.com/Mac/Multimedia/MultimediaWorkingWith.html


Coding Data - Basic Concepts

“Coding means that we attach labels to 'segments of data' that depict what each segment is

about. Through coding, we raise analytic questions about our data from […]. Coding distills

data, sorts them, and gives us an analytic handle for making comparisons with other

segments of data”

“Coding is the strategy that moves data from diffuse and messy text to organized ideas

about what is going on”

"Coding is a core function in ATLAS.ti that lets you “tell” the software where the interesting

things are in your data. ... the main goal of categorizing your data is to tag things to define or

organize them. In the process of categorization, we compare data segments and look for

similarities. All similar elements can be grouped under the same name. By naming something,

we conceptualize and frame it at the same time"

Independent Code / Category Code / Subcode

independent codes

Independent code:



Free code:

Category Code:

inter-code agreement analysis

Subcode:

How to build a code system

Folder:

https://manuals.atlasti.com/Mac/ICA/ICARequirementsForCoding.html


How Groundedness is Counted

Independent Code:

Category Code:

inter-code agreement analysis

positive effects

Subcode:

life is richer

https://manuals.atlasti.com/Mac/ICA/ICARequirementsForCoding.html


Folder:

Experience of

Parenthood

How Density is Counted

code density

networks



Creating and Applying Codes

Video Tutorial: How to code data

Creating New Codes without Coding

Coding Data - Basic Concepts

Importing A List Of Codes

Code / New Code

Cmd+K

https://youtu.be/hAD-BrJl_Yk
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Codes/CodeImportExportCodeList.html


Code Manager by clicking on the + button.

Coding with a New Code

Apply Codes Cmd+J





Working With Multimedia

Data Working With Geo Docs

Code In-Vivo

Working with

Codes > Modifying the length of a coded segment

Code in Vivo

"Over-dependence on in-vivo codes ... 'can limit your ability to transcend to more conceptual

and theoretical levels of analysis and insight' (Saldana, 2009:77). Where they are descriptive

and unique to one person, the coder needs to move on from them quite quickly to generate a

more analytical code."

Display of Coded Data Segments in the Margin Area

https://manuals.atlasti.com/Mac/Multimedia/MultimediaData.html
https://manuals.atlasti.com/Mac/Multimedia/MultimediaData.html
https://manuals.atlasti.com/Mac/Documents/DocumentTypeGeoWorkingWith.html


Applying Existing Codes

Coding Dialogue Drag & Drop

Using the Coding Dialogue

Apply Codes

Drag-and-Drop Coding

Project Explorer

Code Browser

Code Manager



Drag & Drop Coding from the Code Browser

Codes

Working

With Networks

Drag & Drop Coding from the Code Manager



Quick Coding

Quick Coding

cmd+L

Keyboard Shortcuts For Coding

Coding Short-Cut

More Drag-And-Drop Options





Working with Codes

Modifying the Length of a Coded Segment

Removing a Coding

In the Margin Area

Unlink



In the Coding Dialogue

Applied Codes

Replacing a Code via Drag & Drop



Adding, Changing and Removing Code Color

Change Color

Importing code lists

Renaming a Code

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Codes/CodeImportExportCodeList.html


Deleting One or Multiple Code(s)

Delete.



About Renaming, Deleting and Unlinking Codes

applied

codings

global



Duplicating a Code

Duplicate.

Writing Code Comments





Edit Comment



Creating Categories and Subcodes

Video Tutorial: Building a code hierarchy

categories

and subcodes

"If you have a typical project of moderate complexity, it should require no more than 10 top-

level [parent] categories" to cover the topic [...]. Furthermore, most code systems do not go

more than two or three levels deep. If they do, it is likely that the categories being used are

no longer true subcategories of the higher-order categories they are under; and, on a

practical level, it becomes inconvenient for the coder to remember, locate, and effectively

use them"

How to build a code system

folders

https://youtu.be/hchRHoJaYWg


Creating Categories with Subcodes

free

Moving Codes under a Free Code

Add 'x number codes' into...



Creating a Category via Splitting

Split into Subcodes



Add Codes

Add

Undecided

Mutually exclusive:

Mutually Exclusive

Requirements for Coding

Split Code.

https://manuals.atlasti.com/Mac/ICA/ICARequirementsForCoding.html


Creating category and subcodes in the coding dialog

Apply Codes

Adding a category with subcode

Adding a new subcode to an already existing category



Easy coding with subcodes of a category



How to move subcodes out of a category



Organizing Codes in Folders

How to build an effective code system



How to create folders

Add

Code Folder

New

Folder with Selection



How to move items between folders or out of a folder



Automatically Code Data

Code Analysis

AI Coding

Find Concepts and Auto-code

Text search

Expert search

Named Entity Recognition (NER)

Sentiment Analysis

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/SearchAndCode/AICoding.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/SearchAndCode/SearchAndCodeFindConcepts.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/SearchAndCode/SearchAndCodeTextSearch.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/SearchAndCode/SearchAndCodeRegularExpressions.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/SearchAndCode/SearchAndCodeNER.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/SearchAndCode/SearchAndCodeSentimentAnalysis.html


Retrieving Coded Data

Video Tutorial: Retrieving coded data

From the Project Explorer, Code Manager or Code Browser

Quotation Reader

Dock to Navigation Area

https://youtu.be/y2whlc8Izlk
https://manuals.atlasti.com/Mac/Quotations/QuotationReader.html


Simple Retrieval in the Margin Area

Simple Boolean Queries in The Quotation Manager



Search Code

Show

quotations coded with of ANY of the codes.....

any

ANY ALL



ANY: any

ALL all

Video Tutorial: Retrieving data - Quotation Reader

In the Code Manager

Quotation

Reader

https://youtu.be/HWp7czZi4_o
https://manuals.atlasti.com/Mac/Quotations/QuotationReader.html
https://manuals.atlasti.com/Mac/Quotations/QuotationReader.html


Simple Retrieval in the Margin Area



Simple Boolean Queries in The Quotation Manager

any



any

ANY ALL

ANY: any

ALL all

Exporting Results

Export

Creating Reports

https://manuals.atlasti.com/Mac/Reports/Reports.html




Merging Codes

Video Tutorial:

Merge code ... into ...





Splitting a Code

"Inevitably, not all codes you produce will continue to prove useful. Some will be too general,

others too specific to one or two segments of data (see Merging Codes). With the exception

of contextual codes, a category that is so broad or so vaguely defined that it codes a very

large number of passages or very lengthy passages is less likely to be useful in analysis"

Splitting a code into independent codes

Split Code



Add Codes

Add





Split Code

Options

Copy Comments:

Copy links:

Mutually exclusive:

Mutually Exclusive Coding

Mutually Exclusive

Requirements for Coding

Splitting a code into a category and subcodes

Split into Subcodes

https://manuals.atlasti.com/Mac/ICA/ICARequirementsForCoding.html


Add Codes

Add

Undecided

Mutually exclusive:

Mutually Exclusive

Requirements for Coding

Split Code.

https://manuals.atlasti.com/Mac/ICA/ICARequirementsForCoding.html




Building a Code System

How to Begin Building a Code System

merged split



Further Data Analysis

https://manuals.atlasti.com/Mac/Querying/QueryingData.html


document groups





Characteristics of a well-structured code list

Code Co-occurrence Table

Good Practice Tips

The Role of Code Groups in Building a Code System

https://manuals.atlasti.com/Mac/CodeCooccurrence/CodeCoOccurrenceTable.html


Moving on

code co-occurrence table code document table query tool networks

memos

reading the data resulting from a query

Literature

Qualitative Data Analysis: Practical Strategies.

Analysing Qualitative Data: Systematic Approaches.

Qualitative Research for education: An introduction to theory

and methods (2nd ed.).

Constructing Grounded Theory: A Practical Guide Through

Qualitative Analysis.

Basics of Qualitative Research:

Techniques and Procedures for Developing Grounded Theory.

Modes of Thinking for Qualitative Data Analysis.

Qualitative Data Analysis with ATLAS.ti.

Analysing Qualitative Data.

Applied Thematic Analysis.

Applied Thematic Analysis.

Ethnography: Principles in Practice.

International Journal of Social Research Methodology

https://manuals.atlasti.com/Mac/CodeCooccurrence/CodeCoOccurrenceTable.html
https://manuals.atlasti.com/Mac/CodeDocumentTable/CodeDocumentTable.html
https://manuals.atlasti.com/Mac/Querying/QueryTool.html
https://manuals.atlasti.com/Mac/Networks/NetworksAnalyticFunctions.html
https://manuals.atlasti.com/Mac/Memos/MemosAndComments.html
https://manuals.atlasti.com/Mac/Quotations/QuotationReader.html


Qualitative Data Analysis.

Readme first: for a user’s guide to Qualitative Methods.

Handling qualitative data: A practical guide.

The Coding Manual for Qualitative Researchers.

The Ethnographic Interview.

Qualitative analysis for social scientists.

Qualitative

Sociology,



Creating a Codebook

Export Codebook

Export as

Spreadsheet.

Example Outcome:



Working with Memos and Comments

Video Tutorial: Using memos at project begin

Memos

"Memos and diagrams are more than just repositories of thoughts. They are working and

living documents. When an analyst sits down to write a memo or do a diagram, a certain

degree of analysis occurs. The very act of writing memos and doing diagrams forces the

analyst to think about the data. And it is in thinking that analysis occurs"

"Writing is thinking. It is natural to believe that you need to be clear in your mind what you

are trying to express first before you can write it down. However, most of the time, the

opposite is true. You may think you have a clear idea, but it is only when you write it down

that you can be certain that you do (or sadly, sometimes, that you do not)"

report writing

Theory-building

https://youtu.be/bGWvq4Hwx4M


Typical Usage of Memos

project description

research questions

research diary

to do list

bulletin board

literature

analysis

Using Memos as

Document 

Differences between Memos and Comments

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Memos/MemosAndComments.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Memos/MemosAndComments.html


Typical Usage of Comments

Project comment

Document comment

Quotation Comment



Code Comment

Memo Comment



Network Comment

Link Comment

Writing a Comment

Entity Manager

https://manuals.atlasti.com/Mac/Managers/EntityManagers.html


Edit Comment

Creating Memos

toolbar Memo Manager

toolbar:

Memos New Memo

Memo Manager

Memo > Show Memo Manager.

plus

Adding a Quotation to a Memo

Copy



Opening an Existing Memo

Linking Nodes

References



Querying Data

Simple Boolean Retrieval.

Retrieving Coded Data.

Code Document Table

Code Document Table.

Co-occurrence Analysis

Code Co-Occurrence Table.

https://manuals.atlasti.com/Mac/CodeDocumentTable/CodeDocumentTableQuickTour.html
https://manuals.atlasti.com/Mac/CodeCooccurrence/CodeCoOccurrenceTableQuickTour.html


The Query Tool



Smart Codes



Smart Groups

Global Filters





ATLAS.ti Networks

Video utorial: Visualizations in Building the Understanding

network

nodes links

https://youtu.be/P6AlJxTaXvI


Basic Network Procedures

Creating a New Network

Networks New

Network

Adding Nodes to a Network

Add Nodes



Adding Nodes Using the Selection List

Add Nodes

Adding Nodes Using the Selection List

Add Nodes

Add



Adding Nodes via Drag & Drop



Selecting Nodes

Selecting a Single Node



Selecting Multiple Nodes

Method 1

cmd

Method 2



Linking Nodes and Entities



Create Relation create a new relation

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Networks/NetworksCreatingNewRelations.html


Editing a Link



Edit comment:

Reverse link: transitive or asymmetric

link.

Open in Link Manager:

hyperlinks.

Change Relation:

Open Relation in Manager: to create new relations.

Copy:

Unlink:

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Networks/NetworksAboutRelations.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Networks/NetworksAboutRelations.html
https://manuals.atlasti.com/Mac/Hyperlinks/Hyperlinks.html
file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Networks/NetworksCreatingNewRelations.html


Linking Codes to Codes, Quotations to Quotations, Memos to
Memos in Managers and Browsers

Linking two codes in the Code Manager

Create Relation create a new relation.

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Networks/NetworksCreatingNewRelations.html


Linking two quotations in the Quotation Manager - Creating a hyperlink

Linking Entities of Different Types

About Nodes and Links

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Networks/NetworksAboutNodesAndLinks.html




Creating Reports

Export as Spreadsheet

From Managers

Export as Spreadsheet.

From the Quotation Reader

options button Export as

Spreadsheet.



From the Query Tool

Export as Spreadsheet.

Export as Report

Export as Report.

Filter:

Grouping:



Report options:

Save:

Print:



Appendix

System Requirements

Useful Resources:

Get In Touch

System Requirements

Hardware:

Operating systems:



Useful Resources

ATLAS.ti Welcome Screen

The ATLAS.ti Website

https://atlasti.com/

Getting Support

https://support.atlasti.com

Help > Online Resources / Contact Support

Video Tutorials

ATLAS.ti Video Tutorials

Sample Projects

website

https://manuals.atlasti.com/Mac/Intro/IntroductionStartingATLAS.tiWelcomeScreen.html
https://atlasti.com/
https://support.atlasti.com/
https://atlasti.com/video-tutorials
https://atlasti.com/sample-projects


PDF Manuals

ATLAS.ti Full Manual and other documentations.

Research Blog

The ATLAS.ti Research Blog

contact us

Inter-coder Agreement in ATLAS.ti by Prof. Krippendorff

multi-valued

coding. an article written by Prof. Krippendorff

Publications

https://atlasti.com/manuals-docs/
https://atlasti.com/research-hub
mailto:training@atlasti.com
https://manuals.atlasti.com/Mac/ICA/ICARequirementsForCoding.html
https://manuals.atlasti.com/Mac/ICA/ICARequirementsForCoding.html
https://atlasti.com/home/intercoder-agreement-with-atlas.ti-by-prof.-krippendorff.pdf


Carrying out a computer-aided

thematic content analysis with ATLAS.ti. MMG Working Paper 18-0.

CAQDAS and Grounded Theory Analysis. Working Papers WP 16-07

Qualitative Social Network Analysis with

ATLAS.ti: Increasing power in a blackcommunity.

Making Thinking Visible with Atlas.ti: Computer Assisted Qualitative

Analysis as Textual Practices. Forum Qualitative Sozialforschung / Forum: Qualitative Social

Research, 9(2).

https://www.mmg.mpg.de/62142/WP_18-02_Friese-Soratto-Pires_AtlasTI.pdf
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Get In Touch

Social Media

Help > Social Media.

Twitter

Facebook

Instagram

LinkedIn

YouTube channel

https://twitter.com/ATLASti
https://www.facebook.com/ATLAS.ti
https://www.instagram.com/atlas.ti_qdasoftware/
https://www.linkedin.com/in/atlas-ti-gmbh-03249489/
https://www.youtube.com/user/ATLASti01
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